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Résumé 

Les buts de ce travail de stage étaient de développer un outil de calcul du risque de transfert de 

pesticides de parcelles agricoles et viticoles aux eaux de surface, d’utiliser une plateforme ArcGIS 

Online pour permettre la visualisation et la saisie de données agricoles et viticoles par tout un chacun 

sans devoir nécessairement recourir à un logiciel SIG et d’étudier dans quelles mesures l’outil était 

intégrable à la plateforme ArcGIS Online. 

L’outil a été développé en utilisant le ModelBuilder de ArcMap et des portions de code Python. 

L’outil calcule le risque de transfert des parcelles selon différents paramètres et applique une 

symbologie prédéfinie aux entités en fonction du niveau de risque calculé.  

Des données agricoles réelles fournies par l’Ecole d’Ingénieur de Changins ainsi que des données 

fictives (servant à titre d’exemple) ont été intégrées au compte ArcGIS Online de l’Université de 

Genève. Des cartes et des services ont également été intégrés à la plateforme qui a été configurée 

pour pouvoir visualiser et éditer les données depuis internet. Par ailleurs,  l’application « Collector for 

ArcGIS » a également été configurée pour permettre la visualisation et la saisie de données dans le 

terrain grâce à des solutions mobiles.  

L’intégration de l’outil de calcul des risques à la plateforme ArcGIS Online n’as pas été réalisable 

puisque cette fonctionnalité n’existe pas pour l’instant.  

Ce travail permet donc d’une part de calculer le risque de transfert de pesticides avec le logiciel 

ArcMap et d’une autre part de visualiser et de saisir des informations depuis internet avec le compte 

« ArcGIS Online » ou avec l’application « Collector for ArcGIS ».  

Abstract 

The goals of this internship work were to develop a tool to calculate the risks of pesticide transfer 

from agricultural plots to surface waters, to use an ArcGIS Online platform to allow visualization and 

edition of agricultural data by anyone without necessarily having to resort to the use of a GIS 

software, and to examine to what extent it was possible to integrate the tool to the ArcGIS Online 

platform.  

The tool was developed using the ArcMap ModelBuilder and portions of Python code. The tool 

calculates the risk of transfer of the plots according to different parameters and applies a predefined 

symbology to the different entities depending on the level of calculated risk.   

Real agricultural data provided by the Engineering School of Changins as well as fictitious data 

(serving as examples) were incorporated to the ArcGIS Online account of the University of Geneva. 

Maps and services have also been integrated to the platform that was configured to allow for 

viewing and edition of data from internet. In addition, the “Collector for ArcGIS” application was also 

configured to allow for visualization and data entry in the field through mobile solutions.   

The integration of the tool for the calculation of risks to the ArcGIS Online platform was not feasible 

since this capacity does not exist at the moment.   

This work therefore allows calculating the risk of pesticide transfer with ArcMap software and allows 

viewing and entering information through internet with the ArcGIS Online account or the Collector 

for ArcGIS application. 
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1. INTRODUCTION 

Le but de ce rapport est de présenter le travail effectué dans le cadre du stage en entreprise relatif à 

l’obtention du certificat complémentaire en géomatique de l’Université de Genève. Le stage s’est 

effectué à Esri Suisse à Nyon en partenariat avec l’Ecole d’Ingénieurs de Changins. 

1.1.  Présentation des organisations hôtes  

1.1.1. ESRI Suisse 

Esri (Environmental Systems Research Institute) est une entreprise privée fondée en 1969 aux Etats-

Unis en tant que compagnie de consultants en aménagement du territoire. Esri est depuis devenu 

une corporation internationale (Esri Inc.) qui est un des principaux fournisseurs de logiciels de 

systèmes d’information géographiques (SIG) et d’applications de gestion de base de données au 

niveau mondial. Elle développe notamment la suite de logiciels ArcGIS.  

En Allemagne et en Suisse, Esri Inc. est représenté par le distributeur Esri Deutschland GmbH - Esri 

Suisse SA et emploie environ 200 collaborateurs sur 9 sites. 

1.1.2. Ecole d’Ingénieurs de Changins 

L’École d’Ingénieurs de Changins (EIC) est un site de formation en œnologie, en viticulture et en 

arboriculture. Elle est composée d’une Haute Ecole Spécialisée (HES), d’une Ecole Supérieure (ES) et 

d’une Ecole du vin.  

Parallèlement aux activités de formation, l'EIC conduit des projets de recherche appliquée et de 

développement. Ces activités sont menées en collaboration avec le milieu de la viticulture et de 

l'œnologie qui permettent, avec les prestations à tiers, d’améliorer  la qualité de l’enseignement et 

de suivre l’évolution technique et scientifique dans le domaine de la vigne et du vin. Elles répondent 

aussi aux besoins des viticulteurs, des caves et des PME du monde viti-vinicole. 

1.2.  Contexte 

Les pesticides utilisés en agriculture et en viticulture constituent un danger pour l’environnement 

dans pratiquement tous les systèmes agricoles du monde. Le transfert de ces produits dans les eaux 

de surface dépend du type de culture, du ruissellement de l’eau dans les parcelles et de l’érosion 

emportant les produits adsorbés aux particules de terre. Il dépend aussi de la connectivité des 

parcelles avec le réseau hydrique de surface ainsi que du comportement chimique des pesticides. 

L’EIC a développé un système comprenant des procédures combinant SIG, observations sur le terrain 

et traitements de l’information dans le but de fournir un outil à l’exploitant quant aux mesures à 

prendre pour réduire le risque de transfert des pesticides. Un des objectifs du stage était de 

développer un outil grâce au logiciel ArcGIS d’Esri pour permettre d’automatiser le calcul de ces 

risques. Cet outil a été baptisé « Agrotool ».  

1.3.  Objectifs du stage 

L’objectif du stage était de développer un outil (« Agrotool ») de calcul et de représentation du 

risque de transfert des pesticides depuis des parcelle agricoles et viticoles vers les eaux de surface 

grâce au logiciel ArcGIS puis d’utiliser la plateforme ArcGIS Online pour mettre à disposition d’un 
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public ciblé différentes données agricoles sous forme de cartes interactives et enfin d’étudier dans 

quelles mesures l’outil était intégrable à la plateforme.  Le but de l’ interface ArcGIS Online est de 

permettre aux différents utilisateurs d’obtenir des informations spatiales existantes sur différents 

terrains agricoles (superficie, pente, type de sol, connectivité avec le réseau hydrique, etc.) et 

également de pouvoir saisir des données sur le type de culture, sur la gestion courante de ces 

cultures ou sur le type de sol pour permettre par la suite une évaluation du risque de transfert des 

pesticides à l’échelle parcellaire grâce à l’outil « Agrotool ». Ceci sans devoir recourir à un logiciel 

spécialisé et en utilisant uniquement un explorateur internet.  

L’intérêt du travail est de développer un outil qui puisse aider les agriculteurs à améliorer la gestion 

de leurs parcelles grâces aux technologies liées au SIG.  

2. SOURCE DE DONNEES  

Les données utilisées dans le cadre de ce travail proviennent de l’EIC et plus spécifiquement du 

travail de Master de Mme Dorothea Noll intitulé « Appréciation des risques de transfert de pesticides 

: Exemple du N-E du bassin versant du Boiron de Morges » (voir Bibliographie). Les données sont 

pour l’instant privées et limitées à un usage académique et ne peuvent être diffusées publiquement.  

Les logiciels utilisés dans le cadre de ce travail sont « ArcGIS for Desktop 10.1 » d’Esri avec l’ 

extension « spatial analyst » et la plateforme « ArcGIS Online » de l’université de Genève. 

L’application « ModelBuilder » et la fonctionnalité Python pour ArcGIS ont également été utilisés.  

2.1.  Données et informations de base 

Les données obtenues de la part de l’EIC et utilisées pour l’étude sont les suivantes : 

 Des fichiers vectoriels au format « shape » comportant les parcelles agricoles et viticoles et 

les éléments du paysage: VIGNES.shp, CULTURES.shp, talus.shp, routes.shp, 

bande_herbeuse.shp, forêt.shp et coursdeau.shp. Ces fichiers comportent différents champs 

attributaires dont le type de culture, la texture de surface, l’occupation du sol, le type de 

route et le type de forêt. Les données sont toutefois lacunaires et plusieurs entités ne sont 

pas renseignées.  

 Deux modèles numériques de terrain au format raster : mnttotal1m (résolution 1m) couvrant 

118 km2 et MNTtotal5m (résolution 5m) recouvrant la même zone. 

L’extension géographique de ce projet tel que défini dans le cadre du stage est la même que celle du 

travail de Master de Mme Noll et est limité à la région du Mont-sur-Rolle dans le canton de Vaud 

pour des raisons pratiques. Le système de coordonnées employé est le système de coordonnées 

géographiques suisse « CH-1903 ».  
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La Figure 1 ci-dessous présente l’extension géographique du projet. 

 

Figure 1: Extension géographique 

La Figure 2 ci-dessous Illustre les données de base. 

 

Figure 2: Données de base avec vue partielle des orthophotos superposées sur MNTtotal5m 
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Le tableau de la page suivante (Figure 3) présente la grille d’évaluation des risques de transfert de 

pesticides des parcelles reprise du travail de Master de Mme Noll. L’outil « Agrotool » développé 

dans le cadre de ce travail de stage et décrit au chapitre 3 est entièrement basé sur cette grille 

d’évaluation.  

Cette grille détermine pour chaque facteur des classes de risque. Il y a 8 classes différentes 

attribuées à des facteurs intemporels (5 classes) et à des facteurs temporels (3 classes). Les limites de 

ces classes ont été établies sur différentes bases bibliographiques et lorsque des données 

scientifiques n’étaient pas disponibles, selon l’avis d’experts (c.f. travail de Master de Mme Noll).  

Les classes prennent en compte la pente des parcelles, la longueur de leur pente, leur distance au 

réseau hydrographique, les éléments du paysage influençant les transferts dans le sens de 

l’écoulement, la texture de leur surface, l’occupation du sol, le sens de travail du sol et l’état de leur 

surface.  

A chaque classe de risque est associé un coefficient de 0 (pas de risque) à 4 (risque très élevé) puis 

ces différents facteurs sont combinés pour déterminer le risque de transfert total de chaque parcelle. 

Un code couleur éloquent qui correspond au risque attribué à chaque facteur a été choisi et est 

repris tout au long de la présente étude.  
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Figure 3: Grille d'évaluation des risques de transfert de pesticides
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2.2.  Travail préparatoire sur les données 

Le travail de Mme Noll était spécifique et l’analyse du risque était établie au cas par cas sur la base 

de diverses sources d’information.  Les fichiers « shape » (.shp) générés par son travail et repris dans 

le cadre de ce travail-ci ne comportaient pas toujours toute l’information nécessaire au calcul des 

risques. De plus la structure de ces fichiers ne convenait pas à un travail d’automatisation et Il fut 

donc décidé d’établir une nouvelle base de données et de nouveaux fichiers différents des fichiers de 

base de Mme Noll mais qui reprennent un maximum de leur information. Un travail préliminaire sur 

les données reçues a donc été effectué pour faciliter le développement de l’outil « Agrotool » et pour 

permettre une application future de l’outil dans n’importe quel contexte géographique. 

Les opérations suivantes ont été effectuées sur les données de base reçues de l’EIC : 

 Les fichiers « VIGNES.shp » et « CULTURES.shp » ont été fusionnés dans une nouvelle couche 

nommées « parcelles.shp » à l’aide de la fonction « merge » (Arctoolbox ->  data management 

tools -> general -> merge). Puis un remaniement des champs attributaires a effectué pour définir 

les champs nécessaires au calcul du risque. Certains champs ont été modifiés et d’autres ajoutés. 

Les différents champs attributaires de la couche sont illustrés à la figure suivante.  

 

 

Figure 4: Champs attributaires de la couche "parcelles.shp" 

Puis la syntaxe des éléments de texte fut homogénéisée pour correspondre exactement aux 

indicateurs de la grille d’évaluation (à la différence près qu’il n’y a plus de majuscules dans le 

texte). Ce qui était « 40% » dans le champ « recouvrement » du fichier « VIGNES.shp » de Mme 

Noll est devenu «vigne 50 à 30% recouvert » dans le champ « Occupation_sol » du nouveau 

fichier « parcelles.shp » par exemple.  D’autres modifications ont également été effectuées telles 

que de renommer «prairie/pâturage/pré » en « praire permanente » et « verger » en 

« arboriculture/verger ».  Finalement «vigne 70 à 50% recouvert » de la grille d’évaluation a été 

changé en «vigne 70 à 51% recouvert » pour éviter une confusion avec «vigne 50 à 30% 

recouvert » lorsque le recouvrement était de 50%.  

 

 Une nouvelle couche unique a été créée pour les éléments du paysage nommée 

« élément_paysage.shp » qui regroupe les couches « talus.shp », « routes.shp », 

« bande_herbeuse.shp » et  « forêt.shp » de Mme Noll. Cette couche a été créée en 

convertissant les éléments précédents en polylignes lorsqu’ils étaient en polygones (Arctoolbox -

>  data management tools -> features -> features to lines) et en les fusionnants ensembles 

(Arctoolbox ->  data management tools -> general -> merge). Puis certaines informations furent 

modifiées pour correspondre aux descriptions de la grille d’évaluation : 
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- Pour les forêts: les types qui étaient « Null » ont été changés en « forêt », les types qui 

étaient « bosquets » ont été changés en « haie » et les types qui étaient « cordon boisé » 

ont été changés en « forêt ». 

- Pour les routes : les types qui étaient « chemin » ont été changés en « chemin en 

cailloux », les type qui étaient « herbe » ont été changés en « chemin en herbe », les 

types qui étaient « route » sont restés « route », les types qui étaient « chemin de fer » 

ont été changés en « chemin en cailloux ». 

- Les types « talus » sont restés « talus ». 

- Les types «bande herbeuse » ont été changés en « bande enherbée ». 

 

Cette couche inclut deux champs attributaires nommés « Type » et « Risque_élément_paysage ». 

La table de cette couche est présentée à la figure suivante. 

 

 

Figure 5: Table de la couche "élément_paysage.shp" 

 Puis les couches « parcelles.shp » et « élément_paysage.shp » nouvellement créées ont été 

incorporées dans une geodatabase avec la couche « coursdeau.shp » et les 2 MNT (mnttotal1m 

et MNTtotal5m) reçus de l’EIC . La geodatabase a été noméee « Agrotool.gdb ».  

 

 Finalement, pour simplifier la saisie future des informations et éviter des fautes de frappes ou 

d’orthographe lors du renseignement des différents champs, des domaines associés à des valeurs 

codées ont été définis dans la base de donnée « agrotool.gdb » pour les quatre champs texte 

(Etat de surface, Occupation du sol, Sens du travail, Texture de surface) de la couche 

« parcelles.shp » (Figure 6). Ceci permet lors d’une session d’édition de la couche de pouvoir 



Certificat en Géomatique  Université de Genève 

Sven Schmitz-Leuffen Mémoire de Stage SSL.docx P a g e  | 13/52 

sélectionner directement des valeurs attributaires prédéfinies dans une liste déroulante sans 

devoir les entrer manuellement (Figure 7).  

 

Figure 6: Domaines de la base de données "agrotool.gdb" 

 

Figure 7: Exemple de valeurs attributaires prédéfinies pour le champ "Occupation_sol" 

Il est possible d’ajouter toutes sortes d’autres champs attributaires par la suite (nom de l’agriculteur, 

nom du domaine, site internet du domaine, date de saisie, etc.) mais ce travail ci se limite 

uniquement aux données nécessaires pour faire fonctionner l’outil « Agrotool ». 
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3. METHODOLOGIE / Agrotool 

L’outil « Agrotool » qui calcule le risque de transfert de pesticides des parcelles vers les eaux de 

surface consiste en 10 modèles crées dans deux ArcToolbox d’ArcGIS grâce au ModelBuilder.  

 

Figure 8: ArcToolbox "Agrotool" 

Les deux Arctoolbox sont quasiment pareilles. La seule différence est que la première 

(«Agrotool_complet ») comprend le modèle en entier et calcule le risque total en une fois alors que 

la deuxième (« Agrotool_separe ») permet le calcul de chaque classe de risque séparément. L’outil 

peut donc être exécuté de manière globale ou séparée pour calculer une seule classe de risque. Ceci 

offre la possibilité de ne pas devoir relancer tout le modèle complet, qui peut être assez gourmand 

en capacité de calcul, lorsque des modifications sont apportées qui n’affectent qu’une seule classe 

de risque.   

Il y a un donc modèle par classe de risque (8 modèles), un modèle pour calculer le risque total 

(modèle n°9), un modèle pour établir la symbologie relative au code couleur une fois le risque total 

calculé (modèle n° 10) et un modèle pour établir le sens d’écoulement (modèle n° 0).  
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3.1.  Calcul du risque lié aux facteurs intemporels  

3.1.1. Ecoulement 

 

Figure 9: Modèle n° 0 pour l’établissement de l’écoulement 

Ce premier modèle pour l’écoulement n’entre pas directement en compte dans le calcul du risque 

mais Il permet toutefois de générer de générer le fichier des directions d’écoulement 

(FlowDir_MNT1) qui sera réutilisé par la suite et de générer un fichier « écoulement ».  

Ce fichier permet à l’utilisateur de visualiser le sens d’écoulement sur les parcelles et de déterminer 

ensuite si le travail du terrain se fait parallèlement ou perpendiculairement au sens d’écoulement et 

ainsi de pouvoir renseigner le champ « Sens_travail » de la couche « parcelles.shp ». 
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3.1.2. Risque lié à la pente 

 

Figure 10: Modèle n° 1 du calcul du risque lié au facteur pente 

Ce modèle dérive les pentes en pourcent depuis le MNT (Arctoolbox ->  Spatial Analyst -> Zonal -> 

Slope) et crée un fichier raster « Slope_MNT ». Puis il crée, grâce à la fonction « Zonal Statistics » 

(Arctoolbox ->  Spatial Analyst -> Zonal -> Zonal Statistics), un autre fichier raster des parcelles avec 

comme valeur la pente moyenne de chaque parcelle (l’option « statistics type » choisie est 

« MEAN »). Ce raster est ensuite transformé en polygones (Arctoolbox ->  conversion tools -> From 

Raster -> Raster to Polygon) et est joint spatialement (Arctoolbox ->  Analysis Tools -> Overlay -> 

Spatial Join) à la couche « parcelles.shp » ce qui génère un fichier forme nommé 

« parcelles_SpatialJoin.shp ». Le champ « pente » de ce fichier est ensuite calculé (Arctoolbox ->  

Data Management Tools -> Fields -> Calculate Fields ») en reprenant la valeur du champ 

« GRIDCODE » qui correspond à la pente moyenne. Ensuite le champ « Risque_pente » est calculé en 

reprenant les limites établies dans la grille d’évaluation (Figure 3) grâce à un code Python illustré à la 

figure suivante. 
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Figure 11: Code Python pour le calcul du risque associé à la pente 

 

Finalement, la couche « parcelles_SpatialJoin.shp » est jointe (Arctoolbox ->  Data Management 

Tools -> Joins -> Add Join) à la couche « parcelle.shp » et les valeurs des pentes et des risques 

associés sont reprises depuis « parcelles_SpatialJoin.shp » dans « parcelle.shp » puis la jointure est 

supprimée.  

La couche « parcelles.shp » est alors agrémentée des valeurs de pentes moyennes et des risques 

correspondant selon la grille d’évaluation. 
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3.1.3. Risque lié à la longueur de pente 

 

Figure 12: Modèle n° 2 du calcul du risque lié au facteur longueur de pente 

De la même manière que le modèle n° 1, ce deuxième modèle dérive du MNT les altitudes maximales 

et minimales de chaque parcelle ainsi que la pente moyenne en pourcent. Ces opérations génèrent 

trois fichiers raster qui sont ensuite combinés  (Arctoolbox ->  Spatial Analyst Tools -> Map Algebra -> 

Raster Calculator) pour établir la longueur de pente des parcelles. L’altitude maximale est soustraite 

à l’altitude minimale ce qui donne une différence de hauteur (Delta H) qui est ensuite divisée par la 

pente moyenne et multipliée par 100 pour établir une longueur de parcelle en mètres. Puis toujours 

de la même manière que dans le modèle n° 1 les valeurs de longueur de pente et les risques associés 

ont été incorporé dans la couche « parcelles.shp ».  

Cette technique est discutable car approximative mais après vérification manuelle de plusieurs 

parcelles grâce à l’outil « Measure » de ArcGIS, la longueur de pente a été (arbitrairement) jugée 

significativement représentative. L’établissement de ce deuxième modèle à nécessité pas mal de 

temps et a engendré pas mal de questionnements quant à l’adéquation de la technique choisie. 

Plusieurs sources d’information (voir Bibliographie) ont été consultées pour voir ce qu’il se faisait 

dans d’autres modèles similaires de calcul de longueurs de pente et différentes techniques plus 

compliquées ont été essayées mais qui ne donnaient pas de résultats vraiment meilleurs. Il en est 

ressorti qu’il n’existe pas de technique entièrement fiable avec ArcGIS pour établir ce calcul et la 

technique simple utilisée dans ce modèle-ci fut maintenue.  
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3.1.4. Distance au réseau hydrographique 

 

Figure 13: Modèle n° 3 du calcul du risque lié au facteur distance au réseau hydrographique 

Ce modèle commence par attribuer un risque de 0 dans le champ « Risque_dist_hydro » à tous les 

éléments de la couche « parcelles.shp » pour qu’aucun élément ne comporte « Null » comme 

description qui n’est pas pris en compte lors du calcul du risque total (voir § 3.3.3). Puis les éléments 

situés à moins de 200 mètres de la couche « cours_eau.shp » sont sélectionnés (Arctoolbox ->  Data 

Management Tools -> Layers and Table Views -> Select Layer by Location avec « selection 

function: within a distance ») et un risque de 2 leur est attribué grâce à la fonction « Calculate 

Field ». La sélection est ensuite annulée et l’opération est répétée pour les éléments se trouvant à 

moins de 20 mètres des cours d’eau auxquels un risque de 4 est attribué. Les risques liés au facteur 

de distance au réseau hydrographique sont donc de 0, 2 ou 4 selon la grille d’évaluation.  

3.1.5. Eléments du paysage 

 

Figure 14: Modèle n° 4 du calcul du risque lié au facteur éléments du paysage influençant les transferts dans le sens de 
l’écoulement 
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Ce modèle attribue tout d’abord un risque au champ « Risque_élément_paysage » de la couche 

« élément_paysage.shp » en fonction des informations contenues dans le champ « Type ». Ceci est 

réalisé grâce à la fonction « Calculate Field » (Arctoolbox ->  Data Management Tools -> Fields -> 

Calculate Fields ) et du code Python illustré à la figure suivante. 

 

Figure 15: Code Python pour le calcul du risque associé aux éléments du paysage 

Puis le modèle transforme la couche « élément_paysage.shp » en raster (Arctoolbox ->  Conversion 

Tools -> To Raster -> Polyline to Raster) et délimite les basins versant associés aux différents 

éléments du paysage grâce à la fonction « Watershed » (Arctoolbox ->  Spatial Analyst Tools -> 

Hydrology -> Watershed) et à la couche « FlowDir_MNT1» établie précédemment (§ 3.1.1.). Les 

valeurs du fichier raster sont les valeurs des risques conformément à la grille d’évaluation. Le bassin 

versant d’une route aura la valeur de 4 par exemple.  

La fonction « Zonal Statistics » crée ensuite un fichier raster des parcelles avec comme valeur pour 

chaque parcelle le risque moyen des bassins versants des éléments du paysage compris dans la 

parcelle en question. Puis comme pour le modèle n° 1, différentes opérations sont réalisées pour 

reporter ce risque dans le champ attributaire « Risque_element_paysage » de la couche 

« parcelles.shp ». 
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3.1.6. Texture de surface 

 

Figure 16: Modèle n° 5 du calcul du risque lié au facteur texture de surface 

Ce modèle ci attribue simplement un niveau de risque au champ « Risque_texture_surf » de la 

couche « parcelles.shp » en fonction du type de texture de surface contenu dans le champ 

« Texture_surface » au moyen de la fonction « calculate field » et du code Python présenté ci-

dessous.  

 

Figure 17: Code Python pour le calcul du risque associé à la texture de surface 

3.2.  Calcul du risque lié aux facteurs temporels 

3.2.1. Occupation du sol 

 

Figure 18: Modèle n° 6 du calcul du risque lié au facteur occupation du sol 
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Comme pour le risque associé à la texture de surface (§ 3.1.6), ce modèle attribue un niveau de 

risque au champ « Risque_occupation_sol » de la couche « parcelles.shp » en fonction du type de 

texture de surface contenu dans le champ « Occupation_sol » au moyen de la fonction « calculate 

field » et du code Python présenté ci-dessous. 

 

Figure 19: Code Python pour le calcul du risque associé à l'occupation du sol 

3.2.2. Sens du travail du sol 

 

Figure 20: Modèle n° 7 du calcul du risque lié au facteur sens du travail du sol 

Le principe est ici le même qu’aux points 3.1.6 et 3.2.1. Le code Python est présenté à la Figure 21 à 

la page suivante.  
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Figure 21: Code Python pour le calcul du risque associé au sens du travail du sol 

3.2.3. Etat de surface 

 

Figure 22: Modèle n° 8 du calcul du risque lié à l’état de la surface 

Le principe est encore le même qu’aux points précédents. Le code Python est présenté ci-dessous. 

 

Figure 23: Code Python pour le calcul du risque associé à l'état de surface 
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3.3.  Calcul du risque total 

3.3.1. Facteurs intemporels 

Les facteurs intemporels sont séparés en deux classes : les facteurs liés au risque relief et les facteurs 

liés au risque écoulement. Le risque relief comprend les risques liés à la pente et à la longueur de 

pente et le risque écoulement comprend les risques liés à la distance au réseau hydrographique et 

aux éléments du paysage.  

Le calcul des risques liés aux facteurs intemporels s’effectue de la manière suivante: pour le risque lié 

au relief, le risque le plus élevé entre la pente et la longueur de pente est choisi. Puis, pour le risque 

lié à écoulement, le risque le plus élevé entre la distance au réseau hydrographique et les éléments 

du paysage est retenu sauf si un des risque est de 0 alors le risque lié à l’écoulement est de 0. 

Puis le risque lié aux facteurs intemporels est obtenu en considérant la moyenne supérieure arrondie 

des risques liés au relief et à l’écoulement sauf si un des deux risques est de 0. Dans ce cas-là le 

risque intemporel est également de 0.  

Dans l’étude de Mme Noll le coefficient du facteur texture de surface était toujours de 1 car les 

textures de surface pour l’ensemble de la zone d’étude appartenaient à la même classe de risque et 

n’influençaient pas le résultat final. La manière de traiter ce facteur lors du calcul du risque final 

n’était donc pas décrite. L’hypothèse émise dans ce travail ci est que le risque se calcule de la même 

manière que précédemment : la moyenne arrondie supérieure entre le dernier risque calculé et le 

risque lié à la texture de surface est choisi sauf si un des deux risques est de 0, alors le risque 

intemporel total est de 0.  

3.3.2. Facteurs temporels 

Pour établir le risque lié aux facteurs temporels, le même procédé est utilisé. La moyenne supérieure 

arrondie entre le risque lié à l’occupation du sol et le risque lié au sens du travail est calculé tant 

qu’aucun risque n’est de 0. Puis la moyenne supérieure arrondie entre ce résultat et le risque lié à 

l’état de surface est calculé pour obtenir le risque total lié aux facteurs temporels, sauf si un des 

risques est de 0. Si un seul des risques est de 0 alors le risque total est également de 0.  

3.3.3. Risque total 

La moyenne arrondie supérieure entre les risques liés aux facteurs temporels et intemporels est 

calculée si aucun des risques n’est de 0. Si un des deux risques est de 0 alors le résultat final et 

également de 0.  

La Figure 24 à la page suivante présente le modèle de calcul du risque total établi sur la base des 

différents facteurs de risques.  
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Figure 24: Modèle n° 9 du calcul du risque total 

Ce modèle effectue le calcul pour chaque étape décrite précédemment (§ 3.3.1, § 3.3.2 et § 3.3.3).  A 

chaque étape, un champ attributaire temporaire est ajouté à la table de la couche « parcelles.shp », 

puis un calcul est effectué et les éléments sélectionnés par le calcul sont ensuite désélectionnés pour  

garantir que tous les éléments de la table soient à nouveau disponibles pour le calcul de l’étape 

suivante.  
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Figure 25: Code Python pour combiner le risque associé aux facteurs relief et écoulement 

La Figure 25 ci-dessus montre à titre d’exemple le code Python de l’étape du calcul du champ 

temporaire « RT_temp4 ». Cette étape effectue la moyenne entre les champs « RT_temp1 » (facteur 

relief i.e. maximum entre le risque lié à la pente et le risque lié à la longueur de pente) et « RT-

temp3 » (facteur écoulement i.e. maximum entre le risque lié à la distance au réseau hydrographique 

et le risque lié aux éléments du paysage) sauf si un des risque est de 0. En quel cas, le risque retourné 

par le calcul est également de 0. Pour établir la moyenne arrondie supérieure, l’addition des deux 

risques est divisée par 1.9 et non 2. Ceci est dû au fait qu’ArcGIS dans le cadre de ces calculs arrondi à 

l’unité inférieure. Si un risque est de 2 et un autre de 3, la moyenne est de 2.5 mais ArcGIS la 

transforme automatiquement en 2. En divisant par 1.9, la moyenne devient 2.63 et ArcGIS l’arrondit 

à 3.  

Le principe de calcul pour les différentes étapes est toujours le même et est répété 8 fois pour 

obtenir le risque total liés à tous les facteurs. A la fin, les champs attributaires temporaires qui 

servent uniquement aux calculs sont effacés.  

3.3.4. Symbologie 

 

Figure 26: Modèle pour la symbologie et code couleur en fonction du risque total 
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Ce dernier modèle attribue le code couleur tel que défini dans la grille d’évaluation (Figure 3) aux 

différentes parcelles en fonction du risque total calculé par les modèles 1 à 8. Ceci s’effectue grâce à 

la fonction « Apply Symbology From Layer » » (Arctoolbox -> data management tools -> table and 

layer views -> apply symbology from layer) et au fichier de symbologie « parcelles.lyr » 

préalablement établi et qui est fourni avec ce rapport. 

3.4.  Marche à suivre 

Pour utiliser cet outil Agrotool (« Agrotool.tbx ») dans un autre cadre que celui de ce rapport il faut 

impérativement utiliser la base de données « Agrotool.gdb » et le fichier de projet ArcMap 

« Agrotool.mxd » fournis avec ce rapport. La base de données peut être agrémentée par d’autres 

informations et toutes sortes de modifications au projet sont possibles mais la structure et le format 

de ces fichiers de bases doivent être systématiquement employés. Il faut également veiller à ce que 

les environnements de travail et les chemins d’accès aux différents dossiers soient correctement 

définis et qu’aucune entité ne soit sélectionnée avant de lancer l’outil. 

Il est de plus recommandé de vider le cache de l’ordinateur, le dossier « scratch » (dont 

l’emplacement est défini par l’environnement de travail) ainsi que le dossier « Temp » (généralement 

situé ici : C:\Users\AppData\Local\Temp) avant de lancer l’outil pour minimiser le risque de 

rencontrer des erreurs lors de l’exécution des différents modèles. 

La syntaxe des textes descriptifs dans les champs doit absolument être respectée pour que l’outil 

fonctionne. La syntaxe correspond précisément à celle de la grille d’évaluation (Figure 3) sans 

majuscules et à une différence près : « croûte de battance légère avec fissures grossières et fines » a 

été raccourcie en « croûte de battance légère avec fissures » pour que le descriptif fasse moins de 50 

caractères (les champs texte ont été définis pour n’accepter que 50 caractères). Une faute de frappe 

ou d’orthographe empêchera la prise en compte de l’information lors du traitement des données.  Il 

est donc préférable d’utiliser les listes déroulantes (§2.2) lors de la saisie des informations 

attributaires que de les rentrer manuellement au clavier.  

Les paramètres des modèles demandés lors de l’exécution de l’outil complet sont les fichiers 

contenus dans la base de données « agrotool.gdb ». Il s’agit des fichiers « parcelles.shp », 

« élément_paysage.shp » « coursdeau.shp », et des 2 MNT (mnttotal1m et MNTtotal5m). Deux 

paramètres additionnels sont demandé lors de l’exécution de l’outil séparé : « Slope_MNT » et 

Fill_Flowdir ». Ces fichiers sont générés par le modèle n° 0 et le modèle n° 1 et sont repris dans les 

modèles suivants.  

L’outil  « Agrotool » complet comportant tous les modèles est présenté en annexe. 

Les métadonnées du modèle et de la base de données sont comprises dans leurs propriétés et sont 

aussi partiellement présentées en annexe.  
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4. METHODOLOGIE / ArcGIS Online 

Après avoir développé l’outil « Agrotool », le deuxième but du stage était de configurer un compte  

ArcGIS Online pour permettre la consultation et l’édition de données décrites précédemment par des 

personnes ne possédant pas le logiciel ArcMap et d’étudier dans quelle mesure ce travail était 

réalisable directement sur le terrain grâce aux solutions mobiles (smartphones, tablettes, etc).  

4.1.  Généralités 

La plateforme ArcGIS Online permet de créer des cartes et des applications et d’héberger des 

données ainsi que des outils et des services. L’intérêt principal de la plateforme est qu’elle permet le 

partage des informations avec différentes personnes ou groupes de personnes. Différents utilisateurs 

peuvent être invités à utiliser la plateforme avec différents rôles. Il existe trois types de rôles qui sont 

« administrateur », « éditeur » et « utilisateur ». Ces différents rôles ont accès à différents types de 

fonctionnalités.  L’administrateur à accès à toutes les fonctionnalités de la plateforme alors que 

l’éditeur et l’utilisateur sont plus limités. Pour plus d’information quant au fonctionnement de la 

plateforme et aux types d’utilisateurs, veuillez-vous référer au site internet suivant : 

http://www.arcgis.com/home/    

4.2.  Configuration du compte 

L’administrateur d’un compte ArcGIS online à la possibilité de configurer le site de manière à refléter 

les éléments de présentation propres à son organisation. Il peut ajouter un logo et une bannière, 

inclure le contenu de son organisation dans la page d'accueil, définir un fond de carte et une étendue 

par défaut, utiliser ses propres cartes et applications pour les bibliothèques de fonds de cartes et 

définir les paramètres de partage et de sécurité.  

Dans le cadre de ce travail-ci, il n’a pas été possible d’obtenir un compte ArcGIS Online dédié 

uniquement à ce stage et le compte ArcGIS Online de l’Université de Genève a donc été utilisé. 

Puisque le compte de l’Université doit pouvoir servir à d’autres études et que de ce fait le rôle 

d’administrateur est réservé au personnel de l’Université, le rôle d’éditeur a été attribué à ce travail. 

Ceci implique certaines limitations qui n’ont pas permis d’explorer pleinement les fonctionnalités 

d’ArcGIS Online et n’ont pas permis par exemple de configurer le site. 

Cette possibilité existe néanmoins mais pour ce travail-ci un groupe spécifique au sein du compte de 

l’Université a été créé.        

 

Figure 27: Page d'accueil du compte ArcGIS Online de l'Université de Genève 

http://www.arcgis.com/home/
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4.3.  Groupes 

Le rôle d’éditeur était cependant tout à fait suffisant pour accomplir les buts de ce travail de stage. Il 

a permis de créer un groupe de travail et d’y télécharger des données et d’y publier des services.  

En tant qu’éditeur et créateur du groupe, il est possible de gérer les permissions d’accès du groupe. A 

l’heure de la rédaction de ce document ce groupe n’est pas public et n’est partagé avec personne en 

raison du caractère confidentiel des données. Les questions d’accès à ce compte par d’autres 

utilisateurs que moi-même devront être réglée par la suite en accord avec l’Université de Genève et 

l’Ecole d’Ingénieur de Changins. Mais il est possible d’inviter d’autres personnes à rejoindre le groupe 

et de définir leur droits d’utilisation (consultation ou édition).  

 

Figure 28: Page des groupes avec le groupe « AGOL EIC » destiné au travail de stage 

4.4.  Création de cartes et publication de services 

Après avoir créé le groupe, du contenu y fut ajouté. Il s’agit de deux « features », de deux « Web 

Map » et de deux « service definition ». Ces contenus nommé « parcelles_agrotool » et 

« parcelles_EIC » ont été publié sur le compte ArcGIS Online depuis le logiciel ArcMap grâce à la 

fonction « Share as Service » (File -> share as service). « parcelles_EIC » comporte des données 

réelles issues de l’EIC et « parcelles_agrotool » comporte des données fictives crées à titre d’exemple 

(voir § 5 pour de plus amples informations). 

La Figure 29 à la page suivante illustre le contenu du groupe.  

http://www.rapport-gratuit.com/
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Figure 29: Contenu du groupe "AGOL EIC" 

Il existe de nombreuses manières différentes d’intégrer des données à ArcGIS Online mais cette 

manière ci permet d’automatiquement intégrer des projets ArcMap (.mxd) avec leurs contenus et les 

valeurs codées de la géodatabase « agrotool.gdb » ainsi que de déterminer les conditions 

d’utilisation des services ainsi créés.  

La méthode empruntée est la suivante :  

 Deux projets nommés « parcelles_agrotool.mxd » et « parcelles_EIC.mxd » ont été créés 

dans ArcMap.  

 La couche de base « parcelles.shp » a  été ajoutée au projet « parcelles_EIC.mxd » après 

avoir été séparé préalablement en deux fichiers « parcelles 1.shp » et « parcelles 2.shp » 

puisqu’ArcGIS Online n’accepte actuellement pas de fichiers comportant plus de mille entités 

ce qui est le cas du fichier de forme « parcelles.shp ».  

 Les couches « parcelles_exemple.shp » et « ecoulement25.shp » ont été ajoutées au projet 

« parcelles_agrotool.mxd ». La couche « ecoulement25 » a été créée à partir de la couche 

« écoulement.shp » (§3.1.1) en réglant l’ensemble de définition pour que seule les entités 

dont le « GRIDCODE » est plus grand que 25 soient représentées.  Ceci permet une 

visualisation des branches principales de l’écoulement sans toutes les petites ramifications 

superflues. 

 Puis ArcMap a été connecté au compte ArcGIS Online de l’Université avec la fonction « Sign 

In » (File -> sign in) et les identifiants nécessaires. 

 Finalement ces deux projets ArcMap sont publiés en tant que services (File->share as service) 

au compte ArcGIS Online.  

Plusieurs paramètres peuvent être configurés lors de la publication des services. Notamment la 

capacité du service, soit en tant que « tiled mapping » ou en tant que « feature access ». La première 
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capacité ne permet pas d’interaction avec le service une fois publié sur ArcGIS Online alors que la 

deuxième le permet. En choisissant « feature access », il est possible de régler les permissions du 

service, à savoir la possibilité de créer, d’effacer, d’interroger et d’éditer des entités.  

Pour les deux services publiés, la capacité « feature access » a été choisie. Pour le service 

« parcelles_EIC » qui comporte les informations fournies par l’EIC, seule la permission « interroger » 

a été établie alors que pour le service « parcelles_agrotool »  toutes les permissions ont été établies.  

Une fois ces services publiés, deux cartes ou « Web Map » ont été créées dans le groupe « AGOL 

EIC ». Ces deux cartes ont été nommées « parcelles_EIC » et « parcelles_agrotool » et les données 

correspondantes (features) pour chacune de ces cartes ont été ajoutées au moyen de la fonction 

« ajouter des couches » dans ArcGIS Online. Puis des fonds de carte de la bibliothèque ArcGIS Online 

ont été ajoutées (« imagerie » pour « parcelles_agrotool » permettant une meilleure vue de 

l’étendue des parcelles grâce aux images satellitaires et « topographic » pour « parcelles_EIC » 

permettant un rendu plus rapide lors de la consultation) et, finalement, les fenêtres contextuelles 

ont été configurées (contenu -> configurer la fenêtre contextuelle dans « Web Map ») pour 

représenter les données voulues lors de l’interrogation des entités.  

Ces cartes permettent la visualisation et l’édition de données à travers le compte ArcGIS Online grâce 

à la visionneuse de carte « ArcGIS.com ».  

Les services, quant à eux, permettent dans le cadre de ce travail l’utilisation de l’application 

« Collector for ArcGIS ».  

4.5.  Application Collector for ArcGIS 

L’application « Collector for ArcGIS » développée par Esri Inc., permet de récolter des données sur le 

terrain grâce à des solutions mobiles (smartphones, tablettes, etc.). Elle s’utilise de pair avec un 

compte ArcGIS Online ou avec ArcGIS pour serveur.  

Elle est gratuite et est téléchargeables pour les systèmes d’exploitation Android 4.0 et iOS 6.0 (et les 

versions postérieures) en suivant ce lien: http://doc.arcgis.com/en/collector/. 

Il suffit de la télécharger, de l’installer et d’entrer les identifiants nécessaires pour avoir accès au 

compte ArcGIS Online.  

Elle offre plusieurs fonctionnalités (qui sont décrite en suivant le lien précédent) et permet dans le 

cadre de ce travail de saisir des informations sur les parcelles agricoles à l’aide de solutions mobiles 

directement dans le terrain. L’application est prête à l’emploi après avoir suivi les étapes décrites 

dans les chapitres précédents, à savoir : 

 Création d’une géodatabase (agrotool.gdb) et d’une classe d’entité (parcelles.shp) et 

définition des champs attributaires - § 2.2 

 Définition des domaines de la base de données et des valeurs codées - §2.2 

 Création de projets ArcMap et publication des projets en tant que services en « feature 

access » sur le compte ArcGIS Online - § 4.4 

Le chapitre 5.3 détaille le résultat de l’emploi de cette application dans le contexte de ce travail.  

http://doc.arcgis.com/en/collector/
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4.6.  Intégration de l’outil Agrotool dans ArcGIS Online 

Après avoir développé l’outil « Agrotool » pour le calcul du risque de transfert de pesticides des 

parcelles agricoles et après avoir configuré le groupe « AGOL EIC » du compte ArcGIS Online pour 

permettre la visualisation et l’édition de données des parcelles agricoles directement dans le terrain , 

le troisième but du stage était d’étudier dans quelle mesure il était possible d’intégrer l’outil 

« Agrotool » à ArcGIS Online pour permettre le calcul du risque directement dans le terrain. La 

conclusion est ici toute simple : ce n’est pas possible à l’heure actuelle. Il n’existe pour l’instant pas la 

possibilité d’intégrer une ArcToolbox personnalisée à ArcGIS Online. C’est faisable, sauf erreur, en 

utilisant ArcGIS pour serveur mais le but de ce stage était d’exploiter et d’explorer les capacités 

d’ArcGIS Online. 

Il existe néanmoins la possibilité d’effectuer des analyses spatiales avec ArcGIS Online mais elles 

restent assez sommaires pour l’instant.   

La figure suivante illustre les possibilités d’analyse spatiales actuelles avec ArcGIS Online. 

 

Figure 30: Possibilité d'analyses spatiales actuelles avec ArcGIS Online 

Il existe plusieurs fonctions de bases telles que l’agrégation ou la généralisation de données, la 

création de zones tampons, la combinaison et la superposition de couches mais pas encore la 

possibilité d’intégrer une Arctoolbox personnalisée. 

Pour plus d’informations en rapport aux possibilités existantes, veuillez-vous référer au lien suivant : 

http://analysis.arcgis.com/ 

  

http://analysis.arcgis.com/
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5. RESULTATS 

Comme expliqué au § 2.2, les données issues du travail de Master de Mme Noll sont spécifiques à 

son travail et ont été établies au cas par cas.  Ces données ont été réutilisées mais ne sont pas très 

probantes pour ce travail-ci au vu de leur caractère inhomogène et parfois incomplet. Par exemple, 

les fichiers de Mme Noll décrivant les parcelles agricoles comportaient parfois la mention « culture 

sarclée » dans le champ « occupation du sol » ou alors « p.v + rang labouré » dans le champ « Etat de 

surface » ce qui ne correspond à aucun élément de la grille d’évaluation (Figure 3). D’autres entités 

comportaient des champs « NULL » sans information. La qualité du travail de Mme Noll n’est 

absolument pas mise en cause ici mais sans sa connaissance spécialisée du monde agricole, les 

fichiers issus de son travail ne sont pas idéaux pour présenter le fruit de ce travail ci. Ce travail ci s’est 

donc plus appuyé sur la méthodologie fournie par le travail de Mme Noll que sur ses données.  

Pour permettre une meilleure illustration des résultats de ce travail ci, un fichier de parcelles 

agricoles comportant des informations fictives a été établi à titre d’exemple. Ce fichier comporte 

exactement la même structure que le fichier de parcelles réelles. Les sous-chapitres suivants 

présentent à chaque fois les résultats sur les parcelles réelles issues du travail de Mme Noll et sur les 

parcelles fictives. Les numéros des parcelles fictives vont de 5’000 à 5'081 alors que les numéros des 

parcelles réelles vont de 1 à 1’531. Les parcelles fictives se trouvent 1 km au nord des parcelles 

réelles. 

5.1.  Agrotool 

Le résultat de l’exécution de l’Arctoolbox « Agrotool.tbx » sur la couche « parcelles.shp » est 

présenté aux figures suivantes.  

La Figure 31 présente le résultat sur les parcelles réelles et la Figure 32 sur les parcelles fictives. Le 

résultat sur les parcelles réelles n’est pas très probant. Le risque est soit de 0, soit « NULL ». Ceci est 

dû au fait que l’outil « Agrotool » ne prend pas en compte les données sans informations (champs 

« NULL ») ou les données dont la syntaxe ne correspond pas exactement à celle définie dans la grille 

d’évaluation (Figure 3) et retourne à l’issue du calcul soit la valeur « NULL » soit la valeur 0. On peut 

constater que c’est le cas pour toutes les parcelles réelles. Il n’y a donc aucune parcelle réelle qui 

comporte des informations complète avec la syntaxe nécessaire à l’exécution de l’outil « Agrotool ». 

Beaucoup d’efforts ont été investis pour tenter d’homogénéiser et de formater les données de bases 

pour qu’elles soient compatibles avec l’outil mais il n’était au final pas possible de récupérer toutes 

les informations nécessaires. Il faudrait dans l’idéal qu’un ou une spécialiste connaissant bien ces 

parcelles renseigne à nouveau les différents champs et complète les informations manquantes. 

Des parcelles fictives présentées à la Figure 32 ont donc été créées pour permettre une meilleure 

visualisation des résultats potentiels de l’outil. Ces parcelles ont été digitalisées sur la base 

d’orthophotos et correspondent à des périmètres agricoles réels mais les informations entrées dans 

les champs attributaires sont fictives. La topographie est réelle ainsi que le réseau hydrographique et 

les éléments du paysage mais les données relatives à l’occupation du sol, à la texture de surface, à 

l’état de surface et au sens de travail du sol ont été établi de manière aléatoire sur aucune base 

concrète.   

En exécutant l’outil « Agrotool », les différentes valeurs de risques sont calculées puis la symbologie 

choisie est appliquée à chaque parcelle selon le risque total. On peut ici constater que le risque est 
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de 0 pour la majeure partie des parcelles. Ceci est dû à la configuration du réseau hydrographique, 

aux éléments du paysage et à la topographie des lieux  mais principalement à la méthodologie 

employée pour le calcul des risques. En effet, le risque total est établi de telle manière que si un des 

risques est de zéro, le risque total est fréquemment aussi de zéro (§3.3). Il faut donc que toutes les 

classes de risques ne soient pas nulles pour que le risque total ne soit également pas nul ce qui arrive 

assez rarement. En somme, le résultat est tout à fait cohérent et attendu. 
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Figure 31: Résultat de l'exécution de l’Arctoolbox « Agrotool » sur les parcelles réelles 
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Figure 32: Résultat de l'exécution de l’Arctoolbox « Agrotool » sur les parcelles fictives 
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5.2.  ArcGIS Online 

 

 

Figure 33: Web Map ArcGIS Online des parcelles réelles 
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Figure 34: Web Map ArcGIS Online des parcelles fictives avec la couche « ecoulement25 »
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La Figure 33 et la Figure 34 présentent les cartes des parcelles réelles et fictives créées dans ArcGIS 

Online. La fenêtre à gauche comporte les différentes couches de la carte et des fonctionnalités pour 

accéder aux données des couches. La barre du haut comporte différents outils pour modifier la carte, 

la sauvegarder, la partager avec d’autres utilisateurs, etc.  

Une fenêtre contextuelle apparaissant lors de l’interrogation d’entités est également visible sur 

chacune des figures. Cette fenêtre apparait en cliquant sur les parcelles et donne les informations 

relatives à chaque parcelle.  

La Figure 34 comporte la couche des parcelles fictives ainsi que la couche « ecoulement25 ». Cette 

couche a été ajoutée pour que l’utilisateur puisse visualiser le sens de l’écoulement sur les parcelles 

et puisse ainsi renseigner le champ « Sens du Travail » (perpendiculaire ou parallèle à l’écoulement 

ou pas d’écoulement).  

Grâce à ArcGIS Online, ces données peuvent donc être consultées et éditées depuis n’importe quel 

appareil muni d’un explorateur internet  (ordinateur, smartphone, tablette, etc.) sans devoir 

nécessairement avoir recourt au logiciel ArcMap.  Pour les solutions mobiles, il existe l’application 

« Collector for ArcGIS » qui est encore plus simple d’emploi et qui permet également la consultation 

et la saisie de données. Le sous-chapitre suivant présente le résultat de la configuration de cette 

application dans le cadre de ce travail-ci.  

5.3.  Collector for ArcGIS 

Les dix figures suivantes illustrent l’emploi de l’application Collector for ArcGIS sur un IPhone muni 

du système d’exploitation iOS 7.  

 

Figure 35: Page d'accueil de l'application Collector for ArcGIS 

Lors du démarrage de l’application, les deux cartes créées dans ArcGIS Online sont affichées. Il s’agit 

de la carte « parcellles_EIC » des parcelles réelles  et de la carte « parcelles_agrotool » des parcelles 

fictives. La carte « parcelle_EIC » permet uniquement de visualiser et d’interroger les données alors 

que la carte « parcelle_agrotool » permet de visualiser, de créer, d’effacer, d’interroger et d’éditer 

des entités. Les réglages définissant ces permissions ont été effectué lors de la publication des 

services correspondant (§4.4). La Figure 36 et la Figure 37 présentent la vue offerte par l’application 
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lorsque les cartes sont ouvertes. Comme pour bon nombre d’autres applications il est possible de 

zoomer et de se déplacer sur la cartes grâce à diverses opérations tactiles effectuées avec les doigts.  

 

Figure 36: Cartes des parcelles réelles 

 

Figure 37: Cartes des parcelles fictives 
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Figure 38: Carte des parcelles fictives à une échelle plus réduite permettant la visualisation de l’écoulement 

Après avoir suffisamment zoomé sur une portion de la carte des parcelles réelles, la couche 

« écoulement25 » apparaît. Les paramètres de cette couche ont été définis de manière à ce que la 

couche apparaisse seulement à partir d’une certaine échelle pour ne pas encombrer inutilement la 

carte lors de la visualisation de celle-ci à grande échelle. 

 

Figure 39: Sélection d'une parcelle 

L’application permet de sélectionner des entités en pressant manuellement dessus (Figure 39) et de 

pouvoir interroger les entités en pressant ensuite sur la barre d’information qui apparaît lors de la 

sélection (Figure 40).  
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Figure 40: Résultat de l'interrogation d'une parcelle 

Une autre fenêtre apparaît alors qui présente les informations contenues dans les champs 

attributaires de la couche.  

L’intérêt principal de l’application réside toutefois dans la possibilité de pouvoir saisir de nouvelles 

entités depuis le terminal mobile (Figure 41 et Figure 42).  

 

Figure 41: Fenêtre d’actionnement de la  saisie d'une nouvelle entité 

 

Figure 42: Saisie d'une nouvelle entité 
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Il existe plusieurs types de fonctionnalités pour saisir de nouvelles entités. Elles ne sont pas 

explicitement présentées dans ce rapport puisque le but de ce rapport n’est pas de reproduire le 

manuel d’utilisation de l’application mais de présenter les résultats de la configuration de 

l’application dans le cadre de cette étude. Le guide d’utilisation se trouve ici : 

http://doc.arcgis.com/en/collector/ 

Mais il est intéressant de noter que grâce aux fonctionnalités GPS incorporées dans la majeure partie 

des smartphones ou tablette de nos jours, les coordonnées peuvent être automatiquement saisies 

en effectuant physiquement le tour du périmètre choisi avec l’appareil à la main. Il est toutefois 

également possible de saisir des entités manuellement sans faire recours à la fonction GPS.  

Une fois que le périmètre choisi a été saisi et validé, des listes déroulantes sont actionnées qui 

permettent de renseigner les différents champs attributaires. L’exemple suivant illustre le 

renseignement du champ du sens du travail du sol. Grâce à l’affichage de la couche «ecoulement25 » 

l’utilisateur peut visualiser dans le terrain le sens de l’écoulement et peu ainsi renseigner le champ 

attributaire correspondant (Figure 43). 

 

Figure 43: Edition des attributs de la nouvelle entité grâce à une liste déroulante 

Il y a une liste déroulante pour chaque champ attributaire comportant du texte qui offre des choix 

prédéfinis selon les paramètres configurés dans les domaines et les valeurs codées de la base de 

données (§2.2).  

5.4.  Supports électroniques liés à ce rapport 

Les supports électroniques sont contenus dans un dossier nommé « Livrables_CG2013_SSL.zip ». Ce 

dossier comprend trois projets ArcMap (.mxd), deux géodatabases (.gdb), deux Arctoolbox (.tbx), 

trois fichiers de symbologie (.lyr) ainsi que différents sous-dossiers dont le dossier « exemple » qui 

comporte les données fictives. Les deux géodatabases « Agrotool.gdb » présentes dans le dossier 

« Livrables_CG2013_SSL.zip » et dans le sous-dossier « exemple » comportent le même nom et la 

même structure mais ne comportent pas les mêmes informations. Des noms identiques ont été 

gardés pour que l’outil « Agrotool » puisse être utilisé dans les deux cas sans devoir réadapter les 

paramètres du modèle et il faut donc faire attention à ne pas confondre les deux géodatabases.  

http://doc.arcgis.com/en/collector/
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Ces différents fichiers et dossiers comportent toutes les informations relatives à la partie 

« Agrotool » et à la partie ArcGIS Online de ce travail. Les figures suivantes illustrent le contenu de 

ces dossiers.   

 

Figure 44: Contenu du dossier « Livrables_CG2013_SSL.zip » 

 

Figure 45: Contenu du sous-dossier «exemple» 
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6. CONCLUSIONS 

6.1.  Critique de la méthode Agrotool 

L’outil « Agrotool » est composé de huit modèles principaux qui calculent les différentes classes de 

risques et d’un neuvième modèle qui calcule le risque total en fonction des résultats des huit 

modèles précédents. Dans le cas des modèles n°5, 6, 7, 8 et 9 (texture de surface, occupation du sol, 

sens du travail, état de surface et risque total), le calcul du risque est sans équivoque. Il attribue une 

valeur de risque en fonction de paramètres bien définis. Par contre, pour les modèles n°1, 2 et 4 

(pente, longueur de pente, distance au réseau hydrographique et éléments du paysage) les résultats  

du calcul du risque sont moins robustes puisqu’ils comportent plusieurs approximations.  

Le modèle n°1 calcule simplement la pente moyenne d’une parcelle grâce à la fonction « Zonal 

Statistics ». Le calcul du risque lié à la pente dans le travail de Mme Noll était plus abouti puisqu’il 

établissait une valeur de pente basée sur une moyenne des pourcentages du nombre de pixels de 

différents degrés de pente (voir travail de Master de Mme Noll). Ce calcul-là offre une meilleure 

précision mais ne convient pas très bien à un travail d’automatisation.  

Le modèle n°2 calcule une longueur de pente basée sur la division de la différence d’altitude entre le 

point le plus haut et le point le plus bas de la parcelle par sa pente moyenne calculée par le modèle 

n°1. La méthode employée par Mme Noll consistait à tirer un trait entre le point le plus haut et le 

plus bas et à calculer sa longueur. N’ayant pas réussi à automatiser cette méthode avec les outils 

disponibles dans Arctoolbox la méthode simple de la division de la différence de hauteur par la pente 

fut retenue.  

Les résultats du modèle n°4 ne sont pas des plus précis en raison notamment du fait que ce modèle 

établi des moyennes arrondies à l’unité inférieure des risques liés aux différents éléments du 

paysage.  Si, par exemple, une parcelle est située à moitié sur le bassin versant d’une route (risque  = 

4) et à moitié sur le bassin versant d’un chemin en cailloux (risque = 3), le risque résultant sera de 3 

comme si la totalité de la parcelle était située sur le  bassin versant d’un chemin en cailloux. 

Les résultats du modèle n°3 correspondent bien à la réalité du terrain. 

Il serait intéressant de réaliser une analyse de sensibilité entre les méthodes employées dans le cadre 

du travail de Mme Noll et celles employées dans le cadre de ce travail-ci pour voir la différence entre 

les deux méthodes. Les méthodes employées dans le cadre de ce travail-ci ont été vérifiées 

manuellement par pointage aléatoire sur différentes parcelles pour les modèles n°2 et n°4. 

Par vérification manuelle il est entendu que : 

- Les longueurs de pentes de certaines parcelles ont été mesurées avec l’outil de mesure de 

ArcMap et comparées avec les résultats du modèle. 

- Les fichiers raster des bassins versants des éléments du paysage créés par le modèle ainsi 

que la moyenne du risque correspondant établi pour chaque parcelle grâce à la fonction 

« zonal statistics » ont été examinée visuellement pour vérifier leur cohérence par rapport 

aux résultats du modèle.  
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Ces vérifications ont donnés des résultats jugés cohérents et satisfaisants sans être parfaits. Le 

modèle comporte des limites et peut donner des résultats inexacts notamment lorsque les parcelles 

sont sur une topographie à forte pente ou lors du calcul du risque lié aux éléments du paysage 

influençant les transferts dans le sens d'écoulement.  

La méthode employée dans le cadre de ce travail ci diffère donc légèrement de la méthode employée 

par Mme Noll mais les résultats sont relativement semblables après vérification. Un modèle 

favorisant une méthodologie un peu plus simple a été retenue dans le cadre de ce travail-ci pour 

faciliter l’automatisation du calcul.  

Pour la critique de la méthode générale d’établissement des risques, veuillez-vous référer au travail 

de Master de Mme Noll. 

6.2.  ArcGIS Online et Collector pour ArcGIS 

L’intérêt principal d’ArcGIS Online et de Collector for ArcGIS réside, à mon sens, dans le fait de 

pouvoir mettre des outils SIG à disposition d’un public non spécialisé. Dans le cadre de ce travail, il 

est tout à fait imaginable que des agriculteurs ou des viticulteurs saisissent eux-mêmes les données 

relatives à leurs parcelles. Il suffirait de les inviter à rejoindre le groupe « AGOL_EIC » et de leur 

octroyer la permission d’éditer des données. Ces professionnels du monde agricoles pourraient alors 

saisir les données utiles au calcul des risques de transfert des pesticides de leurs parcelles sans devoir 

investir dans des logiciels et sans connaissances avancées des SIG.  

L’idéal serait de pouvoir intégrer l’Arctoolbox « Agrotool » au compte ArcGIS Online pour permettre 

aux agriculteurs et aux viticulteurs de calculer eux-mêmes les risques en actionnant le modèle. Pour 

l’instant, dans le cadre d’un déploiement du travail à grande échelle, il faudrait que les agriculteurs et 

viticulteurs saisissent leurs données avec « Collector for ArcGIS » par exemple, puis qu’une personne 

télécharge les données depuis ArcGIS Online et les intègre dans ArcMap, puis qu’elle exécute le 

modèle et ensuite réincorpore les données comportant le calcul des risques dans ArcGIS Online pour 

permettre par la suite aux agriculteurs de voir le résultat. C’est tout à fait possible, les données 

pourraient être mise à jour par l’EIC de manière hebdomadaire par exemple, mais c’est quand même 

assez compliqué en termes d’organisation et de temps de travail.  

Selon certains bruits de couloirs et rumeurs qui courent sur certains forums, il semblerait qu’Esri soit 

en train de développer une manière d’intégrer des Arctoolbox personnalisées à ArcGIS Online. Je n’ai 

aucune idée de la véracité de cette information mais selon toute logique c’est une fonctionnalité qui 

sera disponible à l’avenir.  

Donc, pour l’instant, un déploiement à grande échelle de ce travail reste un peu compliqué. Et la 

rapidité de la saisie de données grâce à l’application « Collector for ArcGIS » est limité par les 

capacités des réseaux de téléphonie mobile. Avec mon réseau 3G, ce n’est pas très rapide, voire 

assez lent, pour tout avouer.  

Mais à l’avenir, avec des réseaux plus rapides et avec l’Arctoolbox integrée au compte ArcGIS Online, 

il est tout à fait imaginable qu’un agriculteur ou un viticulteur puisse effectuer soi-même le calcul des 

risques directement sur le terrain et de ce fait puisse adapter ses pratiques culturales (sens du 

travail, type de de cultures, etc.) pour diminuer le risque lorsqu’il est élevé.  
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6.3.  Réflexions sur le déroulement du stage  

Le stage s’est déroulé dans des conditions assez particulières puisqu’au début du stage j’étais à 

moitié stagiaire chez Esri Suisse et à moitié employé chez Geocom S.A, une entreprise partenaire 

d’Esri et que j’ai quitté mes fonctions auprès de Geocom pendant la réalisation du stage. Ce départ a 

provoqué quelques modifications dans le déroulement du stage sans pour autant l’affecter.   

La collaboration avec L’EIC s’est très bien déroulée. Dr. Burgos était toujours disponible pour 

répondre à mes questions et m’a fourni toutes les informations et données dont j’avais besoin. Ce fut 

un réel plaisir de pouvoir effectuer ce stage pour l’EIC et le sujet traité m’a particulièrement plu. Je 

pense que l’EIC est un partenaire de choix pour de futurs stagiaires du certificat complémentaire en 

géomatique. 

J’aimerai par ailleurs en profiter pour remercier chaleureusement messieurs Burgos et Dubois pour 

leur disponibilité, leur aide et leur promptitude à me répondre lorsque j’avais des questions ou 

lorsque je rencontrais des problèmes techniques.  

Je ne peux me retenir en outre d’écrire un petit paragraphe concernant les problèmes techniques 

rencontrés et les messages d’erreur. J’ai dû en résoudre à peu près huit-cent-cinquante-sept milliard 

puissance quinze factoriel (au bas mot!).  Que ce soit lors de l’établissement de l’outil Agrotool ou 

lors de la publication des services sur ArcGIS Online depuis ArcMap entre autres. Je me sens obligé 

de le mentionner car la résolution de ces problèmes était extrêmement chronophage et a consisté en 

une bonne partie de ce travail de stage.  C’est tout à fait normal et ça fait partie des risques du 

métier mais ça mérite quand même d’être mentionné vu le temps que j’y ai consacré.  

Finalement, il est demandé dans le document décrivant les consignes du mémoire du certificat 

complémentaire en géomatique (ccg2013_memoire_consignes.pdf) d’expliquer si les méthodes sont 

diffusables et dans quel cadre et sous quelles conditions. Pour ma part tant que ce travail sert à 

d’autres activités académiques ou non lucratives, il est libre de droits. Mais si d’aventure il devait 

servir à des fins privées ou lucratives, mon consentement par écrit pour l’utiliser ainsi que ceux de 

l’Université de Genève et de l’Ecole d’Ingénieur de Changins devront être obtenus. Voilà pour la 

méthode. Pour les données fournies par l’EIC, je rappelle ici qu’elles sont pour l’instant strictement 

privées et non diffusables.  
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8. ANNEXES 

Métadonnées 

Les figures suivantes présentent de manière non exhaustive les métadonnées associées aux 

différents éléments employés dans le cadre de ce travail.  

 

Figure 46: Propriétés du projet Agrotool.mxd 
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Figure 47: Description de l'Arctoolbox "Agrotool_séparé.tbx" 

 

Figure 48: Description de la base de données "Agrotool.gdb" 
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Figure 49: Description de la Web Map " parcelles_agrotool" 

 

http://www.rapport-gratuit.com/
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